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 Successor Tracy Maury pledges continued support... 

PRINCIPAL JILL MCLEOD ANNOUNCES RETIREMENT;  
AIDED SENIORNET OPERATIONS, GROWTH AT SCHOOL 

JILL MCLEOD, the widely-acclaimed educator, principal of the Phantom Lake Elementary 
School in Bellevue, and long-time friend of the SeniorNet Computer Learning Center at the 
school, had decided it's time to retire. 

"After 34 years in public education, the last eight at Phantom Lake Elementary as principal," 
McLeod announced,  "I have decided to retire from the best job that I've ever had. Becoming 
part of the Phantom Lake community felt like a homecoming for me. I love this community so 
this decision has been very wrenching." 
 

McLeod has been in public education for 34 years. She has served the past eight years as 
principal of Phantom Lake, which included the massive project of moving staff, students, along 
with SeniorNet, to a nearby empty school during the demolition and construction of the new, 
larger school on the same site.  

In her statement, McLeod said:  

Taking over the leadership of Phantom Lake will be TRACY MAURY, now principal of the 
Eastgate Elementary School. She immediately announced she wants SeniorNet to continue its all-
volunteer program at Phantom Lake. 

McLeod has been the guiding hand in planning  for the new building and scheduling the 
temporary move to the interim Bellewood School site when the old school was torn down in 2002. 
The larger modern structure opened last year. The return celebration included a joyful march 
by students and faculty, led by McLeod. During the demolition and later new construction, the 
school was located in the nearby empty Bellewood School.  

http://www.seniornetps.org/


 SENIORNET PRES. ADELLA GRANGER said SeniorNet was losing a beloved friend, but also 
gaining a new friend with the incoming principal.  She hailed the close relationship between 
McLeod and SeniorNet, which became part of the school community, including expansion of its 
Granpals program to mentor students there. Granger hailed McLeod's successful efforts to 
create a school atmosphere which encouraged the desire to learn and develop new skills.  

Immediate PAST PRES. HELEN HESKETH who has worked closely with McLeod these many 
past years, declared: 

"What will we do without Jill? For seven years plus I have been personally involved with Jill in 
so many facets of her life and mine. Giving is the middle name for my dear friend, Jill McLeod, 
because she has given and continues to give endlessly to the teachers, students and families, the 
SeniorNet group, her friends, her husband and family." 

Hesketh described McLeod as the creator of a real neighborhood school.  

"Jill's a dreamer - and no dream is too big for her to conquer. She manages a facility that is also 
a neighborhood school that is used by all - Boys and Girls Club, Head Start and SeniorNet of 
Puget Sound. She loves the senior-age over 50 students that occupy a classroom. She loves the 
example of life-long learning that these seniors set for the young students by being in the 
hallways, going to class. 

"When I was SeniorNet President she was my mentor, friend, inspiration, sounding board, and 
advisor and has always been available when I needed her to speak at the last minute for our 
meetings, or to grant SeniorNet special requests, or just to be a listening ear. She was a support 
and inspired me to keep going during my breast cancer surgery and in the months that 
followed." 

The incoming principal, Maury, reiterated her support for the continuation of the SeniorNet 
program there.  

"I absolutely, definitely, without a doubt want SeniorNet to continue at Phantom Lake.  It's a 
terrific program, and very unique in terms of the work it does.  I know the school and district 
would be at a loss without their work and support on behalf of kids and adults," she said. 

Hesketh recalled some of the many highlights of the long relationship between McLeod and 
SeniorNet: 

"She calmed the waters when many of our SeniorNet people were on edge about the move of the 
classroom to a temporary facility in spring of 2002. This was preceded with a walk from 
Phantom Lake Elementary School to our new temporary facility, the Bellewood School, for a 
rally with a police escort.  

"Jill served as the parade majorette, with the students, staff, Granpals and our members. The 
move was accomplished with ease thanks to the cooperation and assistance of our marvelous 
sponsor, Jill McLeod and with the cooperation of her 'elves,'" 

  



TIME TO PLAN FOR CLASSES STARTING IN LATE AUGUST; 

IN-PERSON REGISTRATION SET FOR TUESDAY, JULY 19TH  

 While Spring 2005 classes at SeniorNet are just about completed, Fall 2005 scheduling is in its 
final stages, with classes starting by late August.  Registration for the Fall classes will be held 
Tuesday morning, July 19th, from 10 am--Noon, at New Hope Ministries Church, 15760 NE 4th 
St. Bellevue.  Catalogs will be mailed in early July, according to REGISTRAR LOUISE 
FLORA.  If you are not on our mailing list, please call the voice mail at 206-232-5892 and request 
a catalog. 

 "Attendance records were set with the just completed session," Flora said.  "More than 500 
class spaces were offered with some classes crowded with 14 or 15 students.  One of our most 
popular classes, Photo Editing, was filled with waiting lists at the past in-person registration.  
This Fall, SeniorNet will be offering three Photo Classes."  

 Flora stressed,  "Early registration is a must.  Returning this Fall will be our Potpourri Class.  
This varied class is taught by a team of instructors.  Each with his or her  own specialty.  You 
will learn to create personal mailing labels with your own graphic, Greeting Cards, Letterhead, 
Recipe Cards and Word Art using  Microsoft Word.  Each session will be devoted to one item.  
Early registration is suggested for this class also." 

Registering in-person on July 19 takes priority over mail-in registration, she said.  While 
registration will begin at 10 am., early arrivals can get a number for the registration line at 9:30 
am, when the church doors will open.   

DISCOVER  SATISFACTION, SENSE OF ACHIEVEMENT 
AS A VOLUNTEER ;ATTEND THE  JUNE 21 MEETING 

By HELEN HESKETH 

Ever wonder what our volunteers do? How much time they spend on the areas of responsibility 
they have? How they became a volunteer? How they were placed in the position of leadership 
that they have? Do you feel on the outside from time to time wondering what is going on? 

If you answered yes to any of these questions then mark your calendar and plan to be at the next 
SeniorNet of Puget Sound Membership Meeting on Tuesday morning, June 21, at 10:00 am at 
the New Hope Ministries Church, 15760 NE 4th St, Bellevue. Everyone is invited - members  and 
guests. Even if you have never been to a meeting before and are curious come and join us for a 
couple of hours at the meeting.   

Come and you will hear answers to your questions. You will begin to be in awe of all that takes 
place behind the scenes. Volunteers are the heart and soul of our learning center. Not one of us 
receive any monetary compensation but we do receive a wealth of satisfaction from making and 
seeing things happen as SeniorNet continues to grow and prosper. We have formed some 
wonderful and lasting friendships. 



There are many varied positions that are available for volunteers.  These will not require a lot of 
time, when many heads and hands do the work. However, when one person has to do all of the 
work it can become overwhelming.  

At this meeting you will be able to view what positions are in need of help and assistance, what 
the time commitment would be, and also the responsibilities. You might be just the person to give 
a little of your time and energy to lighten the load of one of our volunteers. Did I hear you say 
you do not know how? All of us are willing to help you be successful in whatever you are 
interested in participating in. 

You may not have the time at this point in your life to be able to help, but come out anyway. Our 
lives and circumstances change from day to day, and what you cannot do today you may be able 
to do in the future. Come and learn about us now and join with us later. (Editor's Note: Helen 
Hesketh, immediate past president, is coordinating the volunteer program) 

MORE SENIORNET VOLUNTEERS SIGN ON AS GRANPALS 
TO HELP YOUNG STUDENTS DURING REGULAR CLASSES  

 Another successful school year for the SeniorNet Granpals program, working with students in 
class, has been hailed by GRANPALS COORDINATOR NANCY HARSH. "This has been a 
very successful year for Granpals in the recruiting department," she said.  "This past month, 
four new Granpals started their volunteering stint in classrooms.  And there are new Granpals 
already lined up to start in the Fall.  This is very helpful as there are always those who for one 
reason or another, usually health, are not able to return.   

 "One of the new Granpals, MARY COLLINS, did her cadet training last year at Phantom Lake 
and is already familiar with the school and the children. While the children's last days of school 
are filled with field trips and parties, so are the Granpals.  VIBES (the regional citizen volunteer 
organization) always puts on a fine spread for all the Bellevue School volunteers at the Bellevue 
Botanical Gardens," she said.  "Phantom Lake also scheduled  a 'thank-you' party at the school 
on May 25th in the library.  This year's party was especially poignant as we bid farewell and our 
appreciation to retiring PRINCIPAL JILL MCLEOD who has offered us all so much support 
and guidance over the years.  We will all miss her hugs."  Other Granpals starting in the 
classroom this past month are: PETER FARNHAM,  JOAN THOMAS and JOHN TUCKER. "  

 FREE ACER SCANNER OFFERED:  Prisa 620P flatbed scanner, 600x1200 dpi 
with 36bit CCD Technology designed for the small office or home. The Prisa 620P has 
a parallel port connection to the computer. The User Manual and installation CD are 
available with the scanner.  This scanner may not be completely compatible with 
Windows XP but performed very well on Windows 98.  Contact Louise Flora - 
louise31@comcast.net.  

 Handy Computer Tips.   

SET UP A PERSONAL SCREEN SAVER: INSTRUCTOR BILL BUMPAS has sent 
along this interesting tip from one of his students to  set up a screen saver to show a 



slideshow of special photos in My Pictures folder. .  Windows XP (and maybe 
prior versions as well) will then randomly display a picture from your My Pictures 
folder for a second or two, then display another one and another one, etc.  This is a 
good way to keep in touch with the vacation or grandchild pictures you have stored on 
your hard drive.   

 To set up: 

1. Right click anywhere on the desktop to bring up the menu 
2. Click on Properties 
3. Click on the Screen Saver tab 
4. Select My Pictures Slideshow on the drop down list. 
5. Choose a delay time.  I use 10 minutes so the screen saver will not kick in while I am in the 
middle of something. 
6. Click on OK. 

After the computer is quiet for the delay time selected in 5 above, the slide show begins.  And, 
like any screen saver, once you move the mouse or press a key on the keyboard, it will shut off. 

DON'T SKIP COMPUTER HARDWARE CLEANING:  Sure, you check for 
viruses, use a firewall program to help block hackers, but what have you done lately 
for your computer hardware and peripherals? Ignore them at your peril when monitors 
grow dimmer, printers jam and keyboards stick, according to BILL HOWARD writing in 
PC MAGAZINE. His excellent article in a recent issue comes up with lots of handy tips 
on safely cleaning the monitor, the keyboard and what to use. Our thanks to HAL 
MOZER for sending it along. The full article can be read by inserting the below URL in 
your browser  http://www.pcmag.com/article2/0,1759,1747017,00.asp 

  

==============================================================
= 

YOUR SENIORNET DATE BOOK FOR JUNE: 

Tuesday June 7th,  at 11:30 am 
No-Host Kaffee Klatch, Meet, Make New Friends 

Crossroads-Bellevue Mall Food Circus, 156th Ave. NE, at NE 8th, Bellevue 
 

Tuesday June 21 , at 10 am 
Monthly Membership Meeting 
New Hope Ministries Church 

15760 NE 4th St., Bellevue 
(Just south of Crossroads Mall) 

 
 Tuesday, June 14th, at 9:30 am-Noon 

http://www.pcmag.com/article2/0,1759,1747017,00.asp


Free June SeniorNet Lab Session 
Open to all: Members, Non-Members and the Just Curious 

SeniorNet Classroom, Phantom Lake Elementary School, Bellevue 
1050 160th Ave. NE, Bellevue 

Computer questions? Sit down with a volunteer expert 
For a hands-on computer solution 

===================================================================================== 

WANT TO SAFELY DUMP THAT OLD COMPUTER?  Bellevue will be having a 
Recycling Collection Day on Saturday, June 18 - 9:00 AM - 3:00 PM at 13620 SE 
Eastgate Way, approximately ¼ mile west of the Eastgate Park and Ride Lot in 
Bellevue.  You can bring one monitor 21" of less for free.  A $10 cash-only fee will be 
charged for each monitor over 21".  Computer equipment, printers, copiers, fax 
machines & cellular telephone equipment will also be accepted.  This equipment  will 
be recycled or reused.   You do not have to be a Bellevue Resident, only a King County 
Resident.   For more information please call - Bellevue Utilities at 425-452-6932. (Our 
thanks to Louise Flora for sending this in) 

HANDY KEYBOARD SHORTCUTS 

(Many readers have asked for a repeat of these handy Word keyboard shortcuts) 

(Thanks to Gordon Young for revisions and updates) 

 
KEY- 

STROKES 
RESULT 

Ctrl+A Select entire document 
Ctrl+B Bolds selection 

Ctrl+C Copies selected item to the 
clipboard 

Ctrl+D Opens font format box 

Ctrl+E Centers selected paragraph 

Ctrl+F Opens Find dialogue box 

Ctrl+G Open GoTo dialogue box 

Ctrl+H Opens Find-Replace box 

Ctrl+I Italicize selected type 

Ctrl+J Selected paragraph Justified 

Ctrl+K Opens insert Hyperlink 

Ctrl+L Selected paragraph left justified 
Ctrl+M Indents selection 0.5% 



KEY- 

STROKES 
RESULT 

Ctrl+M Indent graph 

Ctrl+N Open new document page 

Ctrl+O Opens Open dialogue box 

Ctrl+P Opens print dialogue box 

Ctrl+R Selection paragraph right 
justified 

Ctrl+S Saves document 
Ctrl+Shift+M Unindent paragraph 

Ctrl+T Inserts 0.5" hanging indent 
Ctrl+U Underlines selected items 

Ctrl+V Pastes item from the clipboard. 
Ctrl+W Closes current window 

Ctrl+X Cuts selection to the clipboard 

Ctrl+Y Repeats last keystrokes 

Ctrl+Z Undo your last action 

Alt+A Open Table menu 

Alt+E Opens Edit menu 

Alt+F Open File menu 

Alt+H Opens Help menu 

Alt+I Opens Insert menu 

Alt+I, S Opens the Symbol dialog box 

Alt+O Opens Format menu 

Alt+R Open Draw menu 

Alt+Shift+D Insert current date 

Alt+T Opens Tool menu 

Alt+V Opens View menu 

Alt+W Opens Window menu 

Shift+F7 Opens Thesaurus for word 
where cursor us placed 

Ctrl+Alt+D Inserts End note 

Ctrl+Alt+I Toggle between active Word 
doc, Print prevue 



(NOTE: Those submitting news items for consideration are asked to keep them brief, 
and email them before the 25th of the month. All news items subject to editing. Please 
send to editor at b26flyer@comcast.net) 

==================================================================================== 

If you wish to receive this free monthly newsletter, update your email address or unsubscribe, rush your 
full name, phone and email address to pugetsnet6@qwest.net. NOTE: While all computer-operating tips 
come from usually reliable sources, readers are reminded you use them at YOUR OWN RISK.  Again, in 
case you have friends who are online, and may be interested in taking classes to expand their skills, please 
forward this newsletter to them by clicking Forward when this message is displayed. Then enter their 
address in the To box, and click Send. We welcome your brief personal news items and article items, 
suggestions, sent to the editor at b26flyer@comcast.net 

================================================================ 
President: Adella Granger; Vice President: Delores Davis; Treasurer: Joe Hesketh; Secretary: Martha 
Simon;  Registrar: Louise Flora; Immediate Past President and current Public Relations chair: Helen 
Hesketh; Curriculum Coordinator: John Wise;  Facilities Coordinator: Ken Crandall;  Member-at-
Large: Gordon Young ; Granpals Coordinator: Nancy Harsh; Online Newsletter Circulation: Bob 
Balsley; Online Newsletter Editor: Phil Scheier 

 


